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About the Product 
The Datgel Administrator Tools gINT Add-In consists of 5 tools that provide powerful functionalities and 
capabilities to your existing gINT system. 

 Convert Project Tool: Convert gINT access projects with extended options.  

 Export Tool: Exports data to several files types, either one file per PointID or all PointIDs in 
one file, and allows the user to define a filter.  

 Find and Set Property Tool: Find or Set the property of a database, table or field in gINT.   

 SQL Tool: Builds and executes SELECT, UPDATE, INSERT and DELETE SQL statements. 

 Lookup List Check Tool: Checks all tables and fields in the gINT project for lookups and 
verifies the value with the lookup source. 

You need to complete the installation procedure (see Installation and Licensing on page 1) and activate 
(see Datgel Product Licensing System User Guide) before you can use the Administrator Tool. 

This document has been written using gINT v8i (8.3) features and settings. 

What is New in Version 2? 

 Where applicable, the Datgel Administrator Tools gINT Add-In also now supports gINT SQL 
Server (Enterprise) databases. 

 Convert Projects Tool 

 Sub-folder search depth 

 Informational Field caption grid column, and improved grid control 

 Export Tool 

 Option to create a separate worksheet for each PointID 

 List tables to export 

 Find or Set Property Tool 

 Replace Substring option added – it is now possible to only partially change a value 

 Batch Mode – This tool gives the user the ability to save an .xml file to record a set 
configuration of settings, and then re-use that configuration as required 

 SQL Tool 

 Project Select Options – it is now possible to run SQL queries by Current Project Only, All 
Projects, and Selected Project(s) in an Enterprise database 

 Lookup List Check Tool 

 Project Select Options – it is now possible to run the Lookup List Check tool against the 
Current Project, All Projects, and Selected Project(s) in an Enterprise database 

Support 

12 months support and maintenance is included with the license purchase, and the support and 
maintenance subscription may be renewed on an annual basis.  For technical support please email 
support@datgel.com or call +61 2 8202 8600. 

mailto:support@datgel.com
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System Requirements 

gINT 

The product will run using gINT 8.2 or higher. The Enterprise database option require gINT 8.3 or 
higher 

The product will run using gINT Logs, gINT Logs Plus (8.2 or order), gINT Professional, and gINT 
Professional Plus.   

Hardware and Operating System 

Same system requirements as gINT 8.2, see: http://www.gintsoftware.com/products_requirements.html. 

Required Windows Components 

1. Windows Installer 3.1 

2. .NET 3.5 Framework SP1 

Conventions and typography used in this guide 

Note: Tips and additional Information to help you. 

> Used to indicate a series of menu commands. 

e.g. Select File > Open.  

| Used to indicate a gINT Application Group, Application, Table Group or Table , e.g. 
DATA DESIGN | Project Database 

Bold Text Items you must select, command buttons, or items in a list. 

e.g. Navigate to UTILITIES | Convert Projects (4
th

 tab). 

Italics Emphasis Use to emphasize the importance of a point such as parameters. 

e.g. Data Entry – Check Omit Must Save prompt when save is required 

CAPITALS Names of keys on the keyboard. for example, SHIFT, CTRL, or ALT. 

KEY+KEY Key combinations, for example CTRL+P, or ALT+F4. 

Code Snippet Indicates a code snippet within a paragraph 

Code sample Indicates a sample program codes inserted in user guide e.g. 

public override string ToString () 

File name or path Used for formatting file name and paths e.g. di_lib.glb or  

V:\10 gINT\Datgel Install Files\ 

Table_Name Database table name, e.g. POINT_TABLE. 

Field_Name Database field name; e.g. PointID 

Command line Command line, presented exactly as it must be entered e.g. 

cdir 

Field Colours 

Each of the fields in the project tables have been coloured to improve the data entry process as 
indicated below in Table 1. 

http://www.gintsoftware.com/products_requirements.html
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Table 1 – Field Colours  

Field Colour Field Name and Explanation 

 Yellow gINT Key Field – mandatory data entry 

 Pastel Purple 
AGS Data – data associated with the AGS Data 
Interchange Format 

 Pastel Green 
Calculated Field – data is written to this field by Datgel’s 
code 

 Pastel Beige 
Data Entry Field – data should be entered into this field, 
or data in this field influences the calculation 

 Pastel Red 
Legacy Data Field – historic data entered here, is 
typically from an old database 

 Pastel Blue 
Output Option – used to control how data displays on a 
report 

 Pastel Orange 
Remark or Metadata Field – additional data associated 
with the primary information 

 Grey Read-only 
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1 Installation and Licensing 

1.1 Installation Overview 

There are three parts to the installation process: 

 Install DLL programs 

 Merge gINT library objects 

 Validate the product license 

The first two steps can be performed in any order and are described below. The validation procedure 
must be done last and is described in the Datgel Product Licensing System User Guide. 

1.2 Package Contents 

Your software purchase may have come with the following contents: 

 Applications CD which normally has the following folders:  
\gINT Files 

\Documentation 

\Installation files  

 A hardware license key 

1.3 Before Installation 

A few basic preparations can help ensure an effortless installation. 

 Make sure that the computer where you plan to install the program meets the minimum 
hardware and software requirements.  

 Connect your PC to the Internet before installation (must have a working Internet connection).  

 The Administrator Tool requires that the Microsoft .NET 3.5 framework is installed on the PC 
prior to the installation of the Tool.  If your PC does not have the .NET 3.5 framework installed, 
then it will be automatically downloaded and installed during the Tool installation process.  

 Log into the PC with Administrator privileges before starting installation. 

 It is recommended that you exit out of other applications that maybe running on your PC. 

 Close gINT before you start installation. 

 Keep the serial number and license number handy. 

1.4 Install DLL Programs  

1. If you received an installation CD, then insert the CD and browse to the folder  
\Installation Files 

2. Double click the file named Setup.exe 

3. Click Run to begin installation. 

Follow the on screen instructions when installation begins. 
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4. Click Next on the Welcome to the Datgel Administrator Tool Setup Wizard dialog. 

 

5. Scroll and carefully read the License Agreement, and choose option I Agree, and click Next. 

 

Alternatively choose I Do Not Agree and click Cancel if you disagree with the license 
agreement. The installation will stop and exit.  

6. On the Select Installation Folder dialog, either accept the default folder (recommended) or 
select Browse to specify the folder where you want to install the Administrator Tool. 
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7. Leave Everyone bulleted to indicate that anyone logged onto the PC can use the Administrator 
Tool. 

Click Next when ready. 

 

 OPTIONAL Click on Disk Cost to view the disk space statistics. Click OK when done. 

 

8. Click Next to start installation. 
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9. Observe the progress bar to monitor installation progress  

 

10. Click Close when the Installation Complete dialog is displayed. 

 

1.5 Merge gINT Library Objects 

Note: If Step 1.5 has already been completed by Datgel’s developers, yourself or a colleague, then proceed 

to Step 1.6 Validate License. 

Proceed with the following steps to merge the gINT Library components into your Library file.  

1. Make a backup copy of your existing library file. By default this is located at: 

C:\Users\Public\Documents\Bentley\gINT\libraries 

2. Start gINT, open the library and the project file you wish to use with Datgel Administrator Tool 
gINT Add-In. 

The opened project and library files are displayed at the top of the gINT Window. 

 



 

 

Administrator Tools gINT Add-In 2 –  Datgel 
User Guide 5 DAT-UG-001 - 2.01 - May 2011 
 

3. Select UTILITIES | Lib Merge/Copy. 

 

4. Check the bullet that reads Merge From. 

5. In the Source Library File pane, browse the installation CD for file  
Datgel Administrator Tool lib #.##.glb where #.## is the version number. 

6. Check the bullet that reads Select All. 

7. Check the bullet that reads Query On Overwrite. 
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8. Select the Add-Ins and gINT Rules Modules source tables and click  button to move 
selected tables from the Available Source Tables pane on the left to the Tables to Merge/Copy 
pane on the right side. 

 

9. Click Execute. 

10. Click  button to move the selected items (highlighted blue) from the Available Items pane 
to the Items to Process pane on the Add-Ins dialog. 

 

11. Click OK to process selected items. 

12. Repeat steps 10 and 11 for all other items. 
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13. Take care to read the overwrite dialog and click Yes if you wish to overwrite the file, ELSE click 
No. 

  

This will merge in the Add-Ins and gINT Rules Modules related to the Tool. 

14. Click OK to finish the merge. 

 

1.6 Validate License 

After installation (and before using the Administrator Tool), validate the user license as described in 
Chapter 3 of the Datgel Product Licensing System User Guide. 

Note: You only need to validate this product when you run the Datgel Administrator Tool in gINT for the first 

time. 

1.7 Upgrading from Version 1 to Version 2 

Considering the Tool is independent of the project files and tables, it is a simple task to upgrade to 
version 2. 

1. Merge the new gINT Library Objects into your library file as described in section 1.5.  Overwrite 
existing objects. 

2. Datgel will email you a URL for the license update file.  Download the file, but do not unzip the 
file.  Follow section 3.2 step 2 or section 3.3 step 3 in Datgel Product Licensing System User 
Guide to update your hardware key to be licensed for version 2. 
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2 Running the Tool Add-Ins 
Select the INPUT | Add-Ins > Datgel Administrator Tools to launch the tool. 

 

The About command will display the About Datgel Administrator Tools form. 
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3 Convert Projects Tool 
The Convert Project Tool does a similar task to the native gINT command UTILITES | Convert Project, 
but provides the option to search folders and sub-folders for gINT projects and list the contents of a field 
on a Project level table that could store the version number of the project file.  This tool was designed to 
help a company gINT Administrator manage the data template file versions of gINT projects stored in 
many folders on a file server. 

 

Select INPUT | Add-Ins > Datgel Administrator Tools > Convert Projects to launch the Datgel 
Convert Projects Tool.  

3.1 Selecting Table Name and Field Name 

To display the value of a field in the selected projects for comparison, enter the table name and field 
name in the text fields before browsing for gINT project files. 

For example Table Name: PROJECT; and Field Name: Data_Template_History 

3.2 Browsing for gINT Project Files 

To browse for gINT project files, you have 3 options: 

 Selected projects – browses a single folder and allows you to select project files in the 
specified folder. 

 All projects in folder – browses to a single folder and it automatically selects all project files 
found in that folder only. 

 All projects in folder and sub-folders – browse to a specified folder and automatically select 
all project files found within the named folder and its sub-folders, to a desired folder level. To 
search all subfolders, leave the default value as 100. 
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Check the desired option and click Browse to continue.  You may set the initial folder path when 
browsing by going to Tools > Set Initial Folder and selecting the root folder that you want the Convert 
Projects Tool to start from.  

Folder Mask – when searching for projects in folder and sub-folders, you can exclude a folder or sub-
folders from being searched by its name by entering the name of the folder in the Folder Mask field. 

The field allows the use of * as a wildcard, and is not case sensitive. 

For example, entering ol* will exclude project files located in folders named old, OLD, Old_1, Old_2, 

etc. 

3.3 Selecting the Projects to Convert 

After browsing for gINT project files, the selected project files are displayed in a table, consisting of the 
project file path, data from the assigned table/field name and a convert checkbox.  By default, all 
projects are unchecked.  Click on the Check All button to check all projects, and Uncheck All to do the 
reverse.  Alternatively, you can manually check the projects you wish to convert by checking the boxes. 

3.4 Selecting the Data Template and Correspondence File 

Set the new data template (*.gdt), and optionally the correspondence file (*.gci).   

The following gINT code can be placed in the correspondence file for PROJECT.Data_Template_History in 
order to append the convert file history.  Replace the XX with your new version number. 

"Converted to XX: <<Format(<<Now>>,dd/mmm/yyyy 

hh:nn:ss)>><<CR>><<PROJECT.Data_Template_History>>" 

3.5 Other options 

Refer to the gINT On-line help for a definition of:  

 XBase 

 Remove Non Dependent Keys 

 Tables to skip in the key only removal 
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4 Export Tool 
The Datgel Export Tool is designed to export most gINT exportable data formats to either individual files 
or all in one file.  In addition, the Tool allows the user to write a SQL query or use a pick to define the 
PointID to export. 

This Tool works with the current selected project in an Enterprise database. 

Select INPUT | Add-Ins > Administrator Tools > Datgel Export Tool to launch the Datgel Export 
Tool. 

 

The file formats supported are: 

 Text (*.csv) 

 Text (*.dat) 

 Text (*.txt) 

 Excel (*.xls, *.xlsm, *.xlsx) 

 Database (*.gpj) 

 Database (*.mdb) 

 AGS (*.ags) 

Each file type group has specific options.  For an explanation of these options please read the relevant 
gINT Help file topic. 

You have a choice of exported file configuration: 
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 All PointIDs in one file – this is what gINT’s native exporter does – to define the target file 
click on the File or Folder browse button. 

 Individual file for each PointID – unique to the Datgel Export Tool – to define the target folder 
click on the File or Folder browse button.  Each file will have the same name as the exported 
PointID.  Illegal characters such as \ and / are replaced by _ in the file name. 

Optionally you may specify a data template file for export to gpj and mdb. 

Optionally you may specify a correspondence file to export the PointIDs with by browsing to a 
correspondence file.  

Optionally an SQL statement may be used to define a list of PointIDs to export.  An example SQL 
statement can be inserted using the hyperlink text. 

Optionally you may specify a comma separated list of tables to export in the Selected Tables text field. 
If this field is left blank, then all tables will be exported. 

Default for many of the forms controls can be set and loaded using the Tool menu commands.  The 
saved defaults are populated when the form is loaded.  The initial directory for the File or Folder Browse 
is defined separately.   

AGS Options - Check file after exports: the Export Tool will check if the AGS file has been exported 
correctly. 

Excel Options – Separate worksheet for each PointID: the Export Tool will export the selected 
PointIDs to one Excel file, and table data for each PointID will be placed in separate worksheets. 



 

 

Administrator Tools gINT Add-In 2 –  Datgel 
User Guide 13 DAT-UG-001 - 2.01 - May 2011 
 

5 Find or Set Property Tool 
Every field, table and database has a list of properties, such as type, value, size that determine its 
characteristics.  The Find or Set Property Tool can search, display and set the properties of fields, 
tables and the database of a gINT database. These are generally not accessible through gINT. 

This Tool is potentially dangerous, please be very careful when using it. 

Select INPUT | Add- Ins > Datgel Administrator Tools > Find or Set Property Tool to launch the 
Datgel Find or Set Property Tool. 

 

On this screen: 

1. Find, Set or Replace Substring – Select Find if you wish to retrieve the properties of a field, 
table or database, select Set if you wish to change the value of the properties, or select 
Replace Substring if you wish to change only part of a value. 

2. Type – The types consist of Database, Tables and Fields, where selecting Database brings up 
the properties of the currently open gINT database, selecting tables brings up the properties of 
a table, and fields brings up the properties of a field . 

3. Name – Brings up a list of the names of the properties for the selected type.  This field is used 

with a Like comparison, hence * would return all properties. 

4. Like Current Value – The result can be filtered by the current value of the property. Typing a 
value in this field will return properties that have a value with an exact match with what is typed 

in this box.  The * symbol can be used as a wildcard.  For example, if you wish to search by all 

values that start with p, then you would enter p*. More importantly, if you do not wish to filter 

by current value, you must enter * in the box to signify that you want to search all. These rules 

apply to the Like Table and Like Field fields. The Like Current Value field is required for all 
commands. 

5. Like Table – Filters the results by table name, if you wish to find or set properties in a 
particular table only. This Field is not needed when Database is selected for the type. 
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6. Like field – Filters the results by field name, if you wish to find or set properties in a particular 
field only.  This field is not needed when Table is selected for the type. 

7. New Value – Used only for the Set option, enter a new value you wish to replace the current 
value of the property with. 

8. Batch Mode – Allows you to save multiple value settings used by the tool to an XML file, then 
apply those values over multiple databases. 

9. Table Key Fields & Indices – Returns the table key fields and indices, filtered by table 

10. Find Set Property – Runs the query, and then displays results in an output window. 

11. Exit – Exits the Find or Set Property Tool window. 

12. Reset – Clears all data in the fields on the form. 

5.1 Example 1 - Find 

If you wish to find the property DateCreated in tables that has a name beginning with IMAGE in the 
gINT database, you would enter the values as the following screenshot. 

 

Click Find or Set Prop button, and the result will be shown in the output window. 
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If you are unsure of what to filter by, it is a good idea to search a Name with Like current value, Like 

Table and Like Field with * to retrieve all values. 

5.2 Example 2 - Set 

If you want to change the background colour value of the Elevation field in the POINT table, then enter the 
values as shown the following screenshot. 

 

Click Ok, and the value will be changed. 
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A report will pop up in an output window listing the table and field names in which the changes have 
been made. If the value could not be changed, then the report will show ERROR: followed by the Table 
name, and Field if filtered by Field.  

Note: You may need to leave close the Project and reopen it in order to view some property changes.  
Further some property changes will not apply for the current table, hence we recommend you are not 
viewing an INPUT table that will be edited. 

5.3 Batch Mode 

This tool gives the user the ability to save an .xml file to record a set configuration of settings, and then 
re-use that configuration as required. This is particularly useful when changing values over multiple 
databases. 

To save your configuration, simply tick Record Found Properties to Set Batch XML, Click the ... 
button to browse to the location you wish to save the XML file at, name the file as required, and click 
Find or Set Prop. 

For example, if you wished to save a configuration which changes the gINT background colour of all 
values in the Elevation field of the Point table to black, your screen would look like the following 
screenshot: 
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You should then see an XML file saved in the directory specified. 

You may save multiple configurations to the one xml file. 

To use a previously saved Batch XML file, simply tick Use Batch Mode, browse to the location you 
previously saved the file at, select the file, and then click Find or Set Prop.  

 

After clicking Find or Set Prop, the code steps through to configuration(s) stored in the xml file, and the 
following output window should appear, showing the settings from the XML file: 
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5.4 Table Key Fields and Indices 

This tool lists the key field and indices information for the tables defined by the filter.  The filter only 
uses the Like Table field.  This information is probably only useful to a developer who needs to 
understand the gINT Access table relationships, primary keys, indices and constraints.   

To run this function set the Like Table function, click on the Table Key Fields and Indices button.  The 
report will automatically appear in an output window. 
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6 SQL Tool 
SQL Tool can display the results of SELECT SQL queries and executes other query types such as 
UPDATE, INSERT and DELETE.   

This Tool is potentially dangerous, be very careful when using it and make a backup for your database prior 

to running an update, delete or insert statement. 

An explanation of the SQL language is beyond the scope of this manual.  Please refer to the following 
web sites for information on SQL: 

http://www.w3schools.com/sql/default.asp 

http://www.intermedia.net/support/sql/sqltut.asp 

Select INPUT | Add-Ins > Datgel Administrator Tools > SQL Tool to launch the Datgel SQL Tool. 
The procedure is fairly straightforward and referring to the following screen shot: 

1. Choose the SQL statement you want to write by clicking on the appropriate button. Note the 

lowercase syntax e.g. <fieldname> is included as a guide only and should be overwritten or 

deleted before execution of a command. 

2. Choose the database to run the query against – Project or Library 

3. Paste the desired table and field names from the list. Note, by only using table and field names 
taken from the drop down list, you drastically reduce the chance of getting SQL read errors. 

4. Optional. Use the In Library button to bring up the full path name for the current library file. 

5. Choose between Current Project Only, All Projects, and Selected Project(s).The Current 
Project Only option checks the current project, All Projects checks every project, and 
Selected Project(s) allows you to select multiple projects, by clicking Browse and then 
selecting the projects you wish to use. 

Note: This option only works for gINT Enterprise databases, and the following error will appear 
if using an access-based gINT database. 

Click on Execute. 

6. Click on Reset Query to clear the SQL statement box, and Click on Reset Result to clear the 
results box. 

http://www.w3schools.com/sql/default.asp
http://www.intermedia.net/support/sql/sqltut.asp
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Note that Execute displays the results in the white box below the query, whereas gINT Query will bring 
up a gINT window to display the results. 

6.1 Exporting Data using the SQL Tool  

If you want to export the result of an SQL statement to an Excel File, you can use the gINT Query 
option. If the command is properly executed, then this will bring up a window as below. 

 

The window will contain the result of your query and give you the option to either send the result to the 
printer or to Export your result. Choose Export and then in the second window be careful to choose the 
type as Excel 2007 (*.xlsx). 

WARNING: Due to current program limitations, you are currently unable to Append or Overwrite existing 

files.  Always create a new file when using the SQL Tool export option.  
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7 Lookup List Check Tool 
The Datgel Lookup List Check Tool scans the current project’s table fields to see if the field requires a 
lookup, compares the values of the fields with the values in the lookup source, and then writes any 
problems in a text file. This tool is useful when checking if imported data is compatible or compliant with 
the lookup lists in the current database/library, and is also useful for checking the integrity and validity 
of the existing data in the database.  

The Tool is available from INPUT | Add-Ins > Datgel Administrator Tools > Lookup List Check 
Tool. 

 

There are three parameters to set before executing the Lookup List Check Tool. 

 Report File – specifies the full path to the file where you want the report file to be saved to. By 

default, the file name will be set to <<project file name>> - <<library file 

name>> <<date time>>.txt but can be changed to anything else as required. Click the … 

Box to browse for a file path. 

 Project Select Options (Only for Enterprise Databases) – The Project Select options allow 
you to select which projects you wish to check lookups in. The Current Project Only option 
checks the current project, All Projects checks every project, and Selected Project(s) allows 
you to select multiple projects, by clicking Browse and then selecting the projects you wish to 
use. 

 Search Options – the search options determine which lookups the tool will search and check. 
The options will check the Must use Lookup and Allow additions in Input check boxes that can 
be seen in field properties or DATA DESIGN | Project Database. 

 

o Must use Lookup Only option will only search for and check fields that only have 
Must use Lookup checked in the field properties. 
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o Must use Lookup and Allow Additions in Input option will only search for and check 
fields that only have Must use Lookup and Allow additions in Input checked in the field 
properties. 

o All Lookups option in the Lookup List Check Tool will search for any field that has a 
value in the Lookup field in the field properties, regardless of any check boxes ticked or 
not.  

o Check is Lookup Source Exists Only (Don’t Check Values) option is useful when 
designing a database to help you identity for lookup configurations with broken or 
missing references. 

When these parameters have been set, click Execute to begin the search process.  A progress bar and 
status text on the bottom left will show you how much of the process has been completed.  Note that 
with large databases (>50MB), the execution process may take some time to complete (+5 minutes). 

When the process has been completed, a report file will be generated at the specified path and opened 
automatically for viewing.  The report header and footer contains general info, such as time 
commenced and total time taken, project and library files and path, the search option chosen.  The 
body of the report contains a list of all the fields that had an error with finding the lookup value.  The 
error will also specify exactly what the erroneous value is, as well as exactly where, by listing the key 
fields and values of the record where the value exists.  The results are sorted in alphabetical order by 
table name, then by field name. 
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